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Welcome to the QuickBooks Software Development Kit (SDK) Version 5.0. This 
software is designed for use with QuickBooks 2006; selected features of this 
software can be used with QuickBooks 2002, 2003, 2004, and 2005 as well. 
The system requirements for the QuickBooks SDK are the same as those for the version of 
QuickBooks that is running. QuickBooks 2006 will run on Windows 2000 and Windows XP, 
QuickBooks 2005 and 2004 will run on Microsoft Windows 98, 2000, Me, or XP operating 
systems. QuickBooks 2002 and 2003 will run on Windows NT, 98, 2000, Me, or XP operating 
systems.(The SDK does not run in unattended mode—that is, with automatic login—on 
Windows 98, First Edition; it does, however, run in unattended mode on Windows 98, Second 
Edition.)
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Support for QuickBooks Products

The following table lists the different versions of QuickBooks and the 
corresponding versions of the qbXML specifications that support them. (Note: 
QuickBooks Basic and the Canadian QuickBooks  Easy Start Edition do not 
support the SDK.)

Version of QuickBooks
qbXML Specification 
Version

QuickBooks 2006 and Enterprise 6.0 (Using 
QBXMLRP2)

5.0, 4.0, 3.0, 2.1, 2.0, 1.1, 
1.0

QuickBooks 2005 (and Enterprise 5.0)
(using QBXMLRP) 

 2.1, 2.0, 1.1, 1.0 

QuickBooks 2005 (and Enterprise 5.0)
(using QBXMLRP2) 

4.0, 3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2005 (and Enterprise 5.0)
(using QBXMLRP) 

 2.1, 2.0, 1.1, 1.0 

QuickBooks 2004 (and Enterprise 4.0)
(using QBXMLRP2) 

3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2004 (and Enterprise 4.0)
(using QBXMLRP) 

2.1, 2.0, 1.1, 1.0

QuickBooks 2003 (R7 and above)
(and Enterprise 3.0)*

2.1, 2.0, 1.1, 1.0

QuickBooks 2003
(and Enterprise 2.0)*

2.0, 1.1, 1.0

QuickBooks 2002 (R2 and above)
(and Enterprise)*

1.1, 1.0 

QuickBooks 2002 (R1)* 1.0

QuickBooks Online Edition (v. 11) 5.0, 4.0, 3.0, 2.1, 2.0

QuickBooks 2005, Canadian Edition
(using QBXMLRP2) 

CA3.0, CA2.0

QuickBooks 2005, Canadian Edition
(using QBXMLRP)

CA2.0

QuickBooks 2004, Canadian Edition
(using QBXMLRP2) 

CA3.0, CA2.0 

QuickBooks 2004, Canadian Edition
(using QBXMLRP)

CA2.0

QuickBooks 2003, Canadian Edition* CA2.0
*Earlier releases of QuickBooks will work with either version of the Request Processor (QBXMLRP2 or 
QBXMLRP). We recommend you upgrade existing applications to use QBXMLRP2. SDK 3.0 and greater features are 
available only with QBXMLRP2; in addition, this Request Processor solves some problems found in the older Request 
Processor.
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The following table lists the different versions of the QuickBooks Foundation 
Class (QBFC) Library and the versions of the qbXML specification that support 
them.

Installation Instructions

IMPORTANT

During SDK 5.0 installation, if the eBay SDK has 
previously been installed on your system, the SDK 4.0 
installer may report a failure registering ebay.SDK.tlb. 
This error can safely be ignored and the installation 
will proceed normally.

To install the SDK using the installer, execute QBSDK50.exe. The installer 
also adds a menu (Start>Programs>QuickBooks SDK 5.0>) that provides 
convenient access to SDK tools, samples, and documentation (including the 
Onscreen Reference). You can also access the qbXML Validator and qbXML 
Test applications through the "Send To" context menu for files.

Registering an Application for QuickBooks Online Edition

Before an application can connect with QuickBooks Online Edition using the 
SDK, it must be registered with the Intuit Developer Network. To register 
your application and obtain an application ID, please follow the instructions in 

QBFC Library qbXML Specification 
Version

QBFC5
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

5.0, 4.0, 3.0, 2.1, 2.0, 
1.1, 1.0, CA3.0, CA2.0

QBFC4
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

4.0, 3.0, 2.1, 2.0, 1.1, 
1.0, CA3.0, CA2.0

QBFC3
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

3.0, 2.1, 2.0, 1.1, 1.0, 
CA3.0, CA2.0

QBFC2_1
   (including support for QuickBooks Online Edition)

2.1, 2.0, 1.1, 1.0

QBFC2 2.0, 1.1, 1.0

QBFC2CA CA2.0

QBFC 1.1, 1.0
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Chapter 3 of the Developer's Guide for QuickBooks Online Edition and visit 
http://appreg.quickbooks.com to register your application.

Importing the Correct Library

For Visual C++ applications (if you are not using the QBFC Library), you need 
to import the library named qbxmlrp2.dll, which is installed in C:\Program 
Files\Common Files\Intuit\QuickBooks. For Visual Basic applications, select 
Project > References from within your VB project. Find “QBXMLRP2 1.0 Type 
Library” in the list and check the box next to it, then click OK. If you don’t 
find the entry in the list, you can browse to it.

Migrating QBFC Applications to Version 5.0

If you want to use SDK 5.0 requests, you will need to change QBFC code to 
refer to the new QBFC Library. For example, in Visual Basic, replace 
“QBFC4Lib” with “QBFC5Lib.” 

See the Developer's Guide for the QBFC Library for additional tips on 
migrating QBFC applications to a new SDK version.

New or Modified Files of Interest

This release includes documentation, tools, and samples. The following files 
and directories may be of particular interest to you:

• This release includes .NET Primary Interop Assemblies (PIAs) for 
QBXMLRP2, QBFC5, QBFC4, QBFC3, and QBFC2.1. These assemblies are 
included in the redistributable installers and merge modules for each 
library. If you have previously built a local interop assembly for use with 
your .NET integrations, please be sure to update them to use the primary 
interop assemblies included with this release instead.

• doc\qbxmlops50.xml
The sample file containing all qbXML requests and responses.

• OSR\OnscreenRef
The Onscreen Reference for SDK 5.0. 

• QBOE connector
Installed in the Windows Program Files\common files\Intuit\QuickBooks 
directory. Provides transparent and easy connectivity to QuickBooks 
Online Edition. This plugin to the QBXMLRP2 request processor is 
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redistributable via the following installer and merge modules: 
QBOEConnector.msm (merge module) and QBOEConnector_Installer.exe 
(installer).

All new samples require QuickBooks 2006, the QBXMLRP2 Request Processor, 
and the QuickBooks 2006 sample product-based company file. The QBXMLRP2 
Request Processor is installed in a variety of ways: automatically by 
QuickBooks 2005 and by the redistributable QBXMLRP2_Installer.exe installer 
and QBXMLRP2.msm merge module. The SDK also installs the request 
processor.

Documentation

This release includes new SDK manuals in both PDF and HTML. Along with the 
other major features in the SDK, the manuals and the Onscreen Reference 
can be conveniently accessed through the Start menu.
For best results, use Internet Explorer version 6 or higher to view the 
Onscreen Reference. If you use Netscape Navigator or Mozilla FireFox, for 
example, you may not be able to view all the information.

Tools

The qbXML Validator tool contains new functionality that allows you to 
verify qbXML requests that correspond to these combinations:

- 5.0, 4.0, 3.0, 2.1, 2.0, 1.1, 1.0 for U.S. editions of QuickBooks

- 5.0, 4.0, 3.0, 2.1, and 2.0 for QuickBooks Online Edition

- CA3.0 and CA2.0 for Canadian editions of QuickBooks

The Validator is installed automatically as part of the SDK installation.  

The SDKTest application is located in the \tools\SDKTest folder.  This useful 
development tool reads a qbXML request file, sends it to QuickBooks, and 
returns a response. The command line version of SDKTest is 
samples\qbdt\cpp\qbxml\sdktest\sdktest.exe.
The file tools\SDKTest\SDKTestPlus3.exe is an enhanced version of SDKTest 
that uses QBXMLRP2 and allows the user to control every aspect of the 
connection to QuickBooks. It supports sending subscription request XML as 
well as data integration XML. The source code for this tool is in 
samples\qbdt\vb\qbxml\SDKTestPlus3.
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The file tools\SubscriptionManager\SubView.exe is a tool for viewing and 
removing application subscriptions from QuickBooks.

Samples

The Samples directory contains a readme.html (which can be accessed from 
Start > Programs > QuickBooks SDK 5.0 > Samples). This file lists each 
sample and provides links to open the project directory, the project itself, and 
the executable form of the application.

The SDK 5.0 installer verifies that the MSXML4.0SP2 API from Microsoft is 
installed on your system. If MSXML is not present, the SDK 5.0 installer will 
install it for you. This API is used by the SDK’s Validator tool and several 
samples. 

Downloading MSXML 4.0

If you want to run the sample applications on a system that does not have 
MSXML installed (for example, if you want to use Remote Data Sharing from 
a system that does not have the SDK installed), you will need to install 
MSXML. In addition, if your application is dependent on MSXML Core 
Services, you will need to redistribute that software in your installer. The 
MSXML Core Services software is available from Microsoft

Building the C++ Samples

The #import “qbxmlrp2.dll” statement in the C++ samples allows these 
applications to use the COM interface supported by the QuickBooks SDK. This 
statement will cause an error when you are building the samples in Microsoft 
Visual Studio if the Include path is not set to include the location of this DLL. 
The DLL is installed with QuickBooks and resides in the QuickBooks common 
directory, currently defined as 
C:\Program Files\Common Files\Intuit\QuickBooks. Add this directory to the 
Include path by choosing the Tools menu, Options command, and the 
Directories tab in Visual Studio.
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UIandEventTest Samples

In order to build the EventHandler C++ sample, you will need to specify the 
QuickBooks executable path for the sample project. The method for doing this 
is different for Visual Studio 6.0 and Visual Studio .NET. 

For Visual Studio 6.0, select "Options" from the "Tools" menu. Select the "Di-
rectories" tab and then select "Executable Files". Add the QuickBooks execut-
able path to the list of directories here.

For Visual Studio .NET, select "Properties" from the "Project" menu. Under the 
"C/C++" options, select "General" and add the QuickBooks executable path to 
the "Additional Include Directories". Under the "MIDL" options, also select 
"General" and add the QB path to "Additional Include Directories".

All of these C++ samples also use QBXMLRP2.DLL in the QuickBooks 
"common" directory. The project files currently specify this path as 
C:\Program Files\Common Files\Intuit\QuickBooks. If this path is different on 
your machine, you will need to change it in the project files.

Known Problems in VB Sample Applications

The Visual Basic sample applications allow you to view a response from 
QuickBooks. If you try to view a response that is greater than 32K, you will 
receive an “Out of memory” error.  This happens because the VB sample 
applications use a TextBox control, which has a 32K limit, rather than a 
RichTextBox control. In a Windows 98 or Windows Me environment, this can 
corrupt memory, and the application might not terminate properly.

There is a known issue (not related to qbXML) with the AddReceivePayment 
sample application. The MS Visual Studio application must be installed before 
you can run AddReceivePayment, or you will receive the following error 
message when you run the application: “Class not registered. You need the 
following file to be installed on your machine. MSSTDFMT.DLL.”

How Versioning is Handled in Subscriptions in SDK 4.0

The event data that is returned can potentially differ depending on the qbXML 
version. For example, in the 4.0 qbXML spec, there is a new tag that could be 
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returned in the QBXMLEvent response called CurrentWindow. If an application 
is designed for the 3.0 spec but not the 4.0 spec, how is this situation handled? 

Beginning with SDK 4.0, the spec version that issued the original subscription 
request determines which data is returned in the response. For example, if 
your application subscribed using qbXML 3.0 (that is, the qbXML version tag is 
set like this: <?qbxml version="3.0"?> ), then the QBXMLEvent data that is 
returned is the data from 3.0, that is, you don't receive additional data made 
available in 4.0.If you needed that data, you would resubscribe using a qbXML 
4.0 subscription request.

In addition, suppose you have a current subscription issued using qbXML 3.0. 
To delete that subscription, you have to issue a SubscriptionDel request with 
the qbXML version tag set to 3.0. The reason for this is that you might want 
to keep 3.0 spec subscriptions for backwards compatibility.

Using Payroll Reports

If your application is accessing a company file that is currently signed up for a 
subscription to a payroll service, you can generate payroll reports and query 
PayrollNonWageItems.

To test this feature, you can use one of Intuit’s sample company files (even 
though it will not be signed up for a subscription to a payroll service). Please 
be aware that QuickBooks will record an artificial creation date to any test data 
that you add to a sample company file.

Using Remote Data Sharing (RDS)

This release includes a redistributable version of Remote Data Sharing 3.0. 
RDS 3.0 works only for applications using QBXMLRP2. Please note that RDS 
3.0 does not support event notification or user interface extensions.

Beginning with SDK 3.0, the Remote Data Sharing (RDS) server supports 
automatic login mode, also called batch mode. In this access mode, 
QuickBooks is installed but not running on the machine with the RDS server. 
Instead, the QuickBooks user authorizes the RDS server to log in automatically 
to the desired set of company files. Subsequently, remote applications can 
access any of these company files. 

Applications using the older Request Processor (QBXMLRP) should use RDS 
2.1.
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Known Bugs and Workarounds

• The following is actually not a bug, but is worthy of note here all the same. 
QuickBooks Simple Start does not support multi-user mode. Accordingly, 
if an integrated application invokes BeginSession and specifies multi-user 
mode, the RequestProcessor will return error code 0x80040436, with the 
message "This application requires Multi User file access mode, but 
QuickBooks Simple Start does not support Multi User access." If the 
application specifies "Do Not Care", they will get single-user mode when 
working with SimpleStart. 

• During SDK 4.0 installation, you may see a message informing you that 
the UI and eBay sample could not be installed. You can safely ignore and 
dismiss this message as it has no effect and the installation will proceed 
successfully.

• The bug mentioned in this workaround is fixed in SDK 4.0. However this 
workaround is included here for those applications that need to work with 
older QuickBooks versions for which the bug fix is not available. In 
previous versions of the SDK, if you send an InventoryAdjustmentAddRq 
with a ValueAdjustment that contains only a NewValue element, then the 
resulting QuantityDifference will incorrectly get set to "blank", which 
QuickBooks interprets as "1".  The workaround for this is to include the 
NewQuantity element in the request, setting the value to the same as the 
previous quantity on hand for that inventory item.

• If you use DeliveryPolicy in both a DataEventSubscription and a 
UIEventSubscription, you could set one to DeliverAlways and the other to 
DeliverOnlyIfRunning. In that case, QB will cache your application’s COM 
pointer if the first event for this application in a company file session is 
associated with the DeliverAlways policy.

• If a user installs a copy of Convertible QuickBooks 2005 but does not 
select one of the available editions (Premier, Accountant, Contractor 
edition, etc), and an SDK application is subsequently started, QuickBooks 
will prompt the user to select an edition. The application’s call to 
BeginSession will fail while QuickBooks is being configured for the 
selected edition. The workaround is to have the user finish the process of 
selecting the desired edition and then restart the SDK application.

• In Enterprise 5.0, if a user name has been used by an SDK application for 
auto-login purposes, and the Administrative user deletes that user name, 
there is no warning dialog posted to alert the administrative user, unlike 
prior releases, and unlike current behavior in other QuickBooks 2005 
editions. However, if the user is deleted, the SDK application will fail 
gracefully the next time it attempts to auto-login, and the appropriate 
error message is displayed so the user can have the administrative user 
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add that user name.

• QuickBooks Canada does not currently return values stored in the 
Company Data Extension fields.  The bug affects QuickBooks Canada 
version 2004 and 2005.
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Bugs Fixed in This Release

• When setting an amount in an SDK mod request that had no decimal point, if the company 
file had the "Automatically place decimal point" preference turned on, the validation code 
would insert a decimal point (e.g., "1000" became "10.00"). This has been fixed.

• In certain situations warnings for TransactionQueryRq were not properly returned. This has 
been fixed as of QuickBooks 2005 R4.

• SDK subscription broke in QuickBooks 2005 for Windows 98 users. This is fixed beginning 
with QuickBooks 2005 R6.

• In the past, if you specified a RefNumberRangeFilter and gave a "ToRefNumber" of "A", you 
would get back records whose RefNumbers started with "A", such as "AAF001", "AF-CM-
01", etc. This behavior was incorrect, as "AAF001" is NOT lexicographically less than "A". 
In QuickBooks 2006, the transaction queries will have the corrected behavior.

• Certain “seemingly random” behavior has been eliminated from the SDK because the style 
settings in QuickBooks no longer influence business logic behavior. This results in some of 
the following changes in behavior to the SDK:

-For estimate add, mod, and query, if the style has markup disabled, we now return the 
markup rate, and the rate correctly shows the unit price before markup

-On invoice add and mod, we now transfer all custom fields from items to line items, 
regardless of style settings. Previously, we only did this for each custom field that was 
enabled on the template.

• More than one SDK app was able to connect to the same company file in SU (single user) 
mode. This bug has been fixed.

• The line endings in the XML stream returned to the client were inconsistent. It was 0x0A 
(LF) for most lines, and 0x0D0A (CRLF) for multi-line fields from QB such as descriptions 
and notes. Now, we drop the CR if it encounters CRLF in the data.

• The SDK did not correctly return custom fields on the group line items. It was looking for 
custom fields on the "group end" line when it really should have been looking in the "group" 
line itself. This bug is now fixed. This may also impact transaction queries, as existing 
custom fields on the group line item will start showing up in query responses containing lines.

• Previously, in some editions of QuickBooks, if the logged in user lacks permissions to modify 
statement charges, the incorrect status Code was returned. The correct code, 3260, is now 
returned.

• Previously, if you modified a PurchaseOrder transaction date (but not the due date or 
expected date), the due date and expected date would get updated if the UI template had these 
fields turned off. Because QuickBooks 2006 implements better UI/business logic separation, 
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this dependency no longer exists. The due date now only gets updated if the user hasn't 
changed the date and it is either a new transaction or the terms have been set. The expected 
(ship) date only gets updated if the user hasn't changed the date and it is a new transaction

• Improved exception handling so that the SDK will always return a parser error if it fails to 
parse the input XML file. Previously, there were some cases where the SDK would return an 
Internal Error.

If You Have Questions . . .

For IDN support, please visit http://developer.intuit.com/support.

For community support, visit http://idnforums.intuit.com.
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Summary of New or Changed Features

This summary is divided into two parts. The first part provides an overview of 
the new features in QuickBooks SDK version 5.0. The second part provides a 
detailed listing of changes at the message and element level. 
Note: The new features listed below apply to QBOE only if explicitly stated.

Part One: Features New or Changed in SDK 5.0

Several highlights of this release have already been described in these 
Release Notes. These highlights include

• New support for QuickBooks Simple Start edition

• New support for CreditCard Refund (ARRefundCreditCard Add/Query)

• New support for credit card payment data in SalesReceiptAdd and 
ReceivePaymentAdd requests

• New support for BuildAssembly: BuildAssemblyAdd/Mod/Query

• New support for SalesReceiptMod: you can now modify SalesReceipts

• New query iterator functionality that makes it easy to walk through a large 
amount of returned query data, in “chunk” sizes that you specify.

• We’ve made a major SDK performance improvement for custom fields on 
line items by adding DataExt to InvoiceLineAdd and InvoiceLineGroupAdd, 
and similar changes to EstimateAdd, SalesOrderAdd, PurchaseOrderAdd, 
SalesReceiptAdd, and CreditMemoAdd. Previously, if you wanted to add 
say, an invoice with 100 line items, each with 2 custom fields, you would 
have to send an InvoiceAddRq, followed by 200 DataExtAddRq requests! 
Now, you can do the equivalent operation in ONE InvoiceAddRq. As a 
result, we ask QuickBooks to save an invoice 1 time vs. 201 times!

• A new QBAuthPreferences method (PutAuthFlags) that specifies which 
QuickBooks editions your application supports.

• Filtering on RefNum has been improved: you no longer need to use 
RefNumCaseSensitive to improve query times on non-numeric ref nums: 
however, you can continue to use the RefNumCaseSensitive tag and you 
may want to use it for instances where you need case sensitivity.
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Part Two: What Changed in SDK 5.0

The following sections contain details on new request and response messages 
as well as on new and changed elements within response aggregates. See the 
updated Onscreen Reference for complete listings of all messages. Also see 
the example file qbxmlops50.xml.

Table 1:  New Requests/Responses in SDK 5.0

Table 2:  Elements Added/Changed in Requests in SDK 5.0

The following items are not listed in the tables because they are almost 
universal and would obscure other important changes if they were listed 
separately:

• The iterator and iteratorID attributes have been added to nearly all query 
requests

Table 3:  Elements Added to Responses and Response 
Aggregates in SDK 5.0

Table 4:  Enumeration Changes in SDK 5.0

Request Category
ARRefundCreditCardAdd Transaction
ARRefundCreditCardQuery Transaction
BuildAssemblyAdd Transaction
BuildAssemblyMod Transaction
BuildAssemblyQuery Transaction
ItemAssembliesCanBuildQuery List
SalesReceiptMod Transaction

Request Element Added or Changed Category
Email max from 99 to 1023

Response/Resp. Aggregate Element Added Category
TBD

Enum Type Enum Value Added Category
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Table 5:  Summary of Changes to Reports in SDK 5.0

Previously Deprecated Features No Longer Supported

IsUsingTimeDataToCreatePaychecks is not allowed for SDK 5.0 since it was deprecated in 4.0. 
Any 5.0 request using it will return a parse error. Older requests should behave as they did before 
- receive a deprecated warning but continue to work.

ColType QuantityOnPendingBuild 
LatestOrPriorState

Reports

TxnType
TxnTypeFilter
TxnDelType
TxnVoidType
TxnEventType

ARRefundCreditCard Request

TxnDataExtType
AssignToObject
RemoveFromObject

ARRefundCreditCard Request

Change Report or Filter Type
QuantityOnPendingBuild column is 
added

Inventory Stock Status by 
Vendors
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